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1. Sobre o ICD2BR 

1.1. Apresentação do ICD2BR 

Primeiramente, agradecemos novamente a confiança em adquirir 
produtos LabTools (uma divisão da Mosaico High Performance 
Solutions) e parabéns pela escolha, pois este produto irá auxiliar 
bastante nos seus projetos. A LabTools lança para o mercado 
nacional o ICD2BR. A divisão de tecnologia Hiware da Mosaico em 
parceria com a equipe de desenvolvimento Microchip se esforçaram 
para desenvolver um produto robusto, de boa qualidade e de ótimo 
preço. Este produto é homologado / licenciado pela Microchip. 
Este depurador / gravador, intitulado ICD2BR, permite de maneira fácil 
e rápida, depurar seus softwares em microcontroladores da linha 10F, 
12F, 16F, 18F, 24F, 24H e dsPIC´s da Microchip. Com este produto 
você irá perceber que seu tempo de projeto vai diminuir 
substancialmente, além de detecção rápida de erros através de 
pontos de parada (breakpoints). Com a preocupação de facilitar a vida 
do desenvolvedor brasileiro, juntamente com o ICD2BR, seguirá o 
soquete padrão de gravação para PIC´s de 8, 18, 28 e 40 pinos. 
Salientamos que, os dsPIC´s não podem ser gravados neste soquete.  
Não podemos esquecer de mencionar nossa preocupação com o bem 
social. A Mosaico, conforme acordo firmado com a Microchip, doará 
3% de toda venda deste produto para instituições de caridade de 
nossa região. 
Nota: O ICD2BR foi desenvolvido e designado para ser utilizado 
no desenvolvimento de aplicações e, portanto, não é 
recomendado o seu uso num processo de produção em larga 
escala. 
 
O kit do ICD2BR que você está adquirindo está composto por: 
 

• 1 ICD2BR – depurador / gravador Microchip; 
• 1 McSoc - Soquete para leitura/gravação (componentes DIP); 
• 1 Cabo de ligação entre o ICD2BR o McSoc e os produtos 

LabTools; 
• 1 CD com este Guia do Usuário, MPLAB versão 7.xx; 
• 1 Cabo padrão USB. 
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1.2. Como o ICD2BR pode ajudar em seus 
projetos 

 
O ICD2BR permite você realizar: 
 

• Depurar as informações de seu código fonte na própria 
aplicacão; 

• Depurar seu hardware em tempo real; 
• Programar um componente que utiliza o protocolo ICSP da 

Microchip. 

1.3. Quais PIC´s o ICD2BR trabalha? 

 
Lista dos PIC´s suportados pelo ICD2BR 
 

Microcontrolador Gravação Depuração Soquete especial 
PIC10F200 x x x 
PIC10F202 x x x 
PIC10F204 x x x 
PIC10F206 x x x 
PIC10F220 x x x 
PIC10F222 x x x 
PIC12F508 x x x 
PIC12F509 x x x 
PIC12F510 x x x 
PIC12F615 x x x 
PIC12F629 x x x 
PIC12F635 x x x 
PIC12F675 x x x 
PIC12F683 x x x 
PIC16F505 x x x 
PIC16F506 x x x 
PIC16F54 x   
PIC16F57 x   
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Microcontrolador Gravação Depuração Soquete especial 
PIC16F59 x   
PIC16F610 x   
PIC16F616 x   
PIC16F627 x   
PIC16F627A x x x 
PIC16F628 x   
PIC16F628A x x x 
PIC16F630 x x x 
PIC16F631 x x x 
PIC16F636 x x x 
PIC16F639 x x x 
PIC16F648A x x x 
PIC16F676 x x x 
PIC16F677 x x x 
PIC16F684 x x x 
PIC16F685 x x x 
PIC16F687 x x x 
PIC16F688 x x x 
PIC16F689 x x x 
PIC16F690 x x x 
PIC16F716 x x x 
PIC16F72 x   
PIC16F73 x   
PIC16F737 x x  
PIC16F74 x   
PIC16F747 x x  
PIC16F76 x   
PIC16F767 x x  
PIC16F77 x   
PIC16F777 x x  
PIC16F785 x x  
PIC16F818 x x  
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Microcontrolador Gravação Depuração Soquete especial 
PIC16F819 x x  
PIC16F83 x   
PIC16F84 x   
PIC16F84A x   
PIC16F87 x x  
PIC16F870 x x  
PIC16F871 x x  
PIC16F872 x x  
PIC16F873 x x  
PIC16F873A x x  
PIC16F874 x x  
PIC16F874A x x  
PIC16F876 x x  
PIC16F876A x x  
PIC16F877 x x  
PIC16F877A x x  
PIC16F88 x x  
PIC16F883 x x  
PIC16F884 x x  
PIC16F886 x x  
PIC16F887 x x  
PIC16F913 x x  
PIC16F914 x x  
PIC16F916 x x  
PIC16F917 x x  
PIC16F946 x x  
PIC16HV785 x x  
PIC18C601 x x  
PIC18C801 x x  
PIC18F1220 x x  
PIC18F1230 x x  
PIC18F1320 x x  
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Microcontrolador Gravação Depuração Soquete especial 
PIC18F1330 x x  
PIC18F2220 x x  
PIC18F2221 x x  
PIC18F2320 x x  
PIC18F2321 x x  
PIC18F2331 x x  
PIC18F2410 x x  
PIC18F242 x x  
PIC18F2420 x x  
PIC18F2423 x x  
PIC18F2431 x x  
PIC18F2439 x x  
PIC18F2450 x x  
PIC18F2455 x x  
PIC18F2458 x x  
PIC18F248 x x  
PIC18F2480 x x  
PIC18F24J10 x x  
PIC18F2510 x x  
PIC18F2515 x x  
PIC18F252 x x  
PIC18F2520 x x  
PIC18F2523 x x  
PIC18F2525 x x  
PIC18F2539 x x  
PIC18F2550 x x  
PIC18F2553 x x  
PIC18F258 x x  
PIC18F2580 x x  
PIC18F2585 x x  
PIC18F25J10 x x  
PIC18F2610 x x  



 

9 

ICD2
BR

 Guia do Usuário

Microcontrolador Gravação Depuração Soquete especial 
PIC18F2620 x x  
PIC18F2680 x x  
PIC18F2682 x x  
PIC18F2685 x x  
PIC18F4220 x x  
PIC18F4221 x x  
PIC18F4320 x x  
PIC18F4321 x x  
PIC18F4331 x x  
PIC18F4410 x x  
PIC18F442 x x  
PIC18F4420 x x  
PIC18F4423 x x  
PIC18F4431 x x  
PIC18F4439 x x  
PIC18F4450 x x  
PIC18F4455 x x  
PIC18F4458 x x  
PIC18F448 x x  
PIC18F4480 x x  
PIC18F44J10 x x  
PIC18F4510 x x  
PIC18F4515 x x  
PIC18F452 x x  
PIC18F4520 x x  
PIC18F4523 x x  
PIC18F4525 x x  
PIC18F4539 x x  
PIC18F4550 x x  
PIC18F4553 x x  
PIC18F458 x x  
PIC18F4580 x x  
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Microcontrolador Gravação Depuração Soquete especial 
PIC18F4585 x x  
PIC18F45J10 x x  
PIC18F4610 x x  
PIC18F4620 x x  
PIC18F4680 x x  
PIC18F4685 x x  
PIC18F6310 x x  
PIC18F6390 x x  
PIC18F6410 x x  
PIC18F6490 x x  
PIC18F6520 x x  
PIC18F6525 x x  
PIC18F6527 x x  
PIC18F6585 x x  
PIC18F65J10 x x  
PIC18F65J15 x x  
PIC18F6620 x x  
PIC18F6621 x x  
PIC18F6622 x x  
PIC18F6627 x x  
PIC18F6680 x x  
PIC18F66J10 x x  
PIC18F66J11 x x  
PIC18F66J15 x x  
PIC18F66J16 x x  
PIC18F66J60 x x  
PIC18F66J65 x x  
PIC18F6720 x x  
PIC18F6722 x x  
PIC18F67J10 x x  
PIC18F67J11 x x  
PIC18F67J60 x x  
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Microcontrolador Gravação Depuração Soquete especial 
PIC18F8310 x x  
PIC18F8390 x x  
PIC18F8410 x x  
PIC18F8490 x x  
PIC18F8520 x x  
PIC18F8525 x x  
PIC18F8527 x x  
PIC18F8585 x x  
PIC18F85J10 x x  
PIC18F85J11 x x  
PIC18F85J15 x x  
PIC18F85J90 x x  
PIC18F8620 x x  
PIC18F8621 x x  
PIC18F8622 x x  
PIC18F8627 x x  
PIC18F8680 x x  
PIC18F86J10 x x  
PIC18F86J11 x x  
PIC18F86J15 x x  
PIC18F86J16 x x  
PIC18F86J60 x x  
PIC18F86J65 x x  
PIC18F8720 x x  
PIC18F8722 x x  
PIC18F87J10 x x  
PIC18F87J11 x x  
PIC18F87J60 x x  
PIC18F96J60 x x  
PIC18F96J65 x x  
PIC18F97J60 x x  
PIC18LF24J10 x x  
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Microcontrolador Gravação Depuração Soquete especial 
PIC18LF25J10 x x  
PIC18LF44J10 x x  
PIC18LF45J10 x x  
PIC24FJ128GA006 x x  
PIC24FJ128GA008 x x  
PIC24FJ128GA010 x x  
PIC24FJ32GA002 x x  
PIC24FJ32GA004 x x  
PIC24FJ64GA002 x x  
PIC24FJ64GA004 x x  
PIC24FJ64GA006 x x  
PIC24FJ64GA008 x x  
PIC24FJ64GA010 x x  
PIC24FJ96GA006 x x  
PIC24FJ96GA008 x x  
PIC24FJ96GA010 x x  
PIC24HJ128GP206 x x  
PIC24HJ128GP210 x x  
PIC24HJ128GP306 x x  
PIC24HJ128GP310 x x  
PIC24HJ128GP506 x x  
PIC24HJ128GP510 x x  
PIC24HJ256GP206 x x  
PIC24HJ256GP210 x x  
PIC24HJ256GP610 x x  
PIC24HJ64GP206 x x  
PIC24HJ64GP210 x x  
PIC24HJ64GP506 x x  
PIC24HJ64GP510 x x  
dsPIC30F2010 x x  
dsPIC30F2011 x x  
dsPIC30F2012 x x  
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Microcontrolador Gravação Depuração Soquete especial 
dsPIC30F2020 x x  
dsPIC30F2023 x x  
dsPIC30F3010 x x  
dsPIC30F3011 x x  
dsPIC30F3012 x x  
dsPIC30F3013 x x  
dsPIC30F3014 x x  
dsPIC30F4011 x x  
dsPIC30F4012 x x  
dsPIC30F4013 x x  
dsPIC30F5011 x x  
dsPIC30F5013 x x  
dsPIC30F5015 x x  
dsPIC30F5016 x x  
dsPIC30F6010 x x  
dsPIC30F6010A x x  
dsPIC30F6011 x x  
dsPIC30F6011A x x  
dsPIC30F6012 x x  
dsPIC30F6012A x x  
dsPIC30F6013 x x  
dsPIC30F6013A x x  
dsPIC30F6014 x x  
dsPIC30F6014A x x  
dsPIC30F6015 x x  
dsPIC33FJ128GP206 x x  
dsPIC33FJ128GP306 x x  
dsPIC33FJ128GP310 x x  
dsPIC33FJ128GP706 x x  
dsPIC33FJ128GP708 x x  
dsPIC33FJ128GP710 x x  
dsPIC33FJ128MC506 x x  
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Microcontrolador Gravação Depuração Soquete especial 
dsPIC33FJ128MC510 x x  
dsPIC33FJ128MC706 x x  
dsPIC33FJ128MC708 x x  
dsPIC33FJ128MC710 x x  
dsPIC33FJ256GP506 x x  
dsPIC33FJ256GP510 x x  
dsPIC33FJ256GP710 x x  
dsPIC33FJ256MC510 x x  
dsPIC33FJ256MC710 x x  
dsPIC33FJ64GP206 x x  
dsPIC33FJ64GP306 x x  
dsPIC33FJ64GP310 x x  
dsPIC33FJ64GP706 x x  
dsPIC33FJ64GP708 x x  
dsPIC33FJ64GP710 x x  
dsPIC33FJ64MC506 x x  
dsPIC33FJ64MC508 x x  
dsPIC33FJ64MC510 x x  
dsPIC33FJ64MC706 x x  
dsPIC33FJ64MC710 x x  
 
Dado: MPLAB versão 7.60 
 
Observações: 
 
1 – O soquete especial é um soquete que é usado somente no modo 
de depuração. Para gravação não há necessidade do uso deste 
soquete. 
Mais informações você pode encontrar em www.microchip.com/icd2 
(documento ICE and ICD Header Information ). 
2 – Dependendo da versão do MPLAB a lista de microcontroladores 
que o ICD2BR suporta pode variar na quantidade de modelos. 
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3 – A lista dos microcontroladores que o ICD2BR suporta não levou em 
consideração os componentes em versões betas do gravador e 
depurador. Isso não significa que os componentes em versões betas 
não irão funcionar, mas pode ter algum problema. Ao sair uma nova 
versão do MPLAB possivelmente estará em versão totalmente 
funcional. 
4 – Microcontroladores PIC10F, dsPIC’s, PIC18 série J, PIC24F e 
PIC24H não podem ser gravados no McSoc. Para dsPIC’s existe um 
soquete apropriado. Mais informações você pode encontrar em 
www.labtools.com.br . 

1.4. Quais PIC´s e dsPIC´s que  o ICD2BR  
suporta? (Tabela de quantidade de 
memória e registros utilizados por modelo 
para depurar) 

 

Recursos utilizados pelas famílias 10F e 12F: 
 
Características gerais: 

• Pino MCLR utilizado para depurar. Não poderá utilizar como 
I/O digital no modo debug. (Exceto para componentes ICD); 

• MCLR/VPP livre para gravação; 
• PGC e PGD reservados para o modo debug. Portanto outras 

funções nestes pinos não estarão disponíveis para depurar; 
• Um nível de pilha não disponível. 

 
 
Tabela de uso: 
 

Tipo Memória de Programa 
usada 

Registradores usados 

PIC10F200/2/4/6 
(PIC16F505-ICD) Nenhum Nenhum 

PIC10F220/2 
(PIC16F506-ICD) 

Nenhum Nenhum 



 

16 

ICD2
BR

 Guia do Usuário

Tipo 
Memória de Programa 

usada Registradores usados 

PIC12F508/509 
(PIC16F505-ICD) 

Nenhum Nenhum 

PIC12F510 
(PIC16F506-ICD) 

Nenhum Nenhum 

PIC12F609/615, 
PIC12HV609/615 
(PIC16F616-ICD) 

0x0300-0x03FF 
0x70 
0x065-0x06F 

PIC12F629 
(PIC12F675-ICD) 0x300-0x3FF 

0x54-0x5F 
0xD4-0xDF 

PIC12F635 
(PIC16F636-ICD) 0x300-0x3FF 

0x65-0x6F 
0x70, 0xF0 
0x170, 0x1F0 

PIC12F675 
(PIC12F675-ICD) 0x300-0x3FF 0x54-0x5F 

0xD4-0xDF 

PIC12F683 
(PIC12F683-ICD) 

0x700-0x7FF 0x65-0x6F 
0x70, 0xF0 

 
Recursos utilizados pela família 16F: 
 
Características gerais: 

• Pino MCLR utilizado para depurar. Não poderá utilizar como 
I/O digital no modo depurador. (Exceto para componentes 
ICD); 

• MCLR/VPP livre para gravação; 
• PGC e PGD reservados para modo depurador. Portanto outras 

funções multiplexadas nestes pinos não estarão disponíveis 
para depurar; 

• Um nível de pilha não disponível; 
• Modo de programação ICSP baixa voltagem desabilitado; 
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Tabela de uso: 
 

Tipo Memória de Programa 
usada 

Registradores 
usados 

PIC16F505 
(PIC16F505-ICD) 

Nenhum Nenhum 

PIC16F506 
(PIC16F506-ICD) 

Nenhum Nenhum 

PIC16F610/ 
PIC16HV610 
(PIC16F616-ICD) 

0x0300-0x03FF 0x70 
0x065-0x06F 

PIC16F616/ 
PIC16HV616 
(PIC16F616-ICD) 

0x0700-0x07FF 
0x65-0x6F 
0x70, 0xF0 
0x170, 0x1F0 

PIC16F627A 
(PIC16F648A-ICD) 0x300-0x3FF  

PIC16F628A 
(PIC16F648A-ICD) 

0x700-0x7FF 

0x70, 0xF0 
0x165-0x16F 
0x170, 0x1F0 

PIC16F630 
(PIC16F676-ICD) 0x300-0x3FF 

0x54-0x5F 
0xD4-0xDF 

PIC16F631 
(PIC16F690-ICD) 

0x300-0x3FF  0x65 - 0x70, 0xF0, 
0x170, 0x1F0 

PIC16F636 
PIC16F639 
(PIC16F636-ICD) 

0x700-0x7FF  
  

0x65-0x6F 
0x70, 0xF0 
0x170, 0x1F0 

PIC16F648A 
(PIC16F648A-ICD)  0xF00-0xFFF 

0x70, 0xF0 
0x165-0x16F 
0x170, 0x1F0 

PIC16F676 
(PIC16F676-ICD) 

0x300-0x3FF  0x54-0x5F 
0xD4-0xDF 

PIC16F677 
(PIC16F690-ICD) 0x700-0x7FF  

0x65 - 0x70, 0xF0, 
0x170, 0x1F0  
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Tipo 
Memória de Programa 

usada 
Registradores 

usados 

PIC16F684 
(PIC16F684-ICD) 

0x700-0x7FF 

0x65-0x6F 
0x70, 0xF0 
0x165-0x16F 
0x170, 0x1F0 

PIC16F685 
(PIC16F690-ICD) 

0xF00-0xFFF 
0x70, 0xF0 
0x165-0x16F 
0x170, 0x1F0 

PIC16F687 
(PIC16F690-ICD)  0x700-0x7FF 

0x65-0x6F 
0x70, 0xF0 
0x170, 0x1F0 

PIC16F688 
(PIC16F688-ICD) 

PIC16F689 
(PIC16F690-ICD) 

PIC16F690 
(PIC16F690-ICD) 

0xF00-0xFFF 
0x70, 0xF0 
0x165-0x16F 
0x170, 0x1F0 

PIC16F716 
(PIC16F716-ICD) 

0x700-0x7FF 0x65-0x6F 
0x70, 0xF0 

PIC16F737/747 0x0F00-0x0FFF 

PIC16F767/777 0x1F00-0x1FFF 

0x70, 0xF0, 
0x165-0x16F 
0x170, 0x1F0 

PIC16F785 
(PIC16F785-ICD)  0x700-0x7FF 

0x65-0x6F 
0x70, 0xF0 
0x170, 0x1F0 

PIC16F87/88 0xF00-0xFFF 
0x70, 0xF0 
0x170, 0x1F0 
0x1E7-0x1EF 
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Tipo 
Memória de Programa 

usada 
Registradores 

usados 

PIC16F818 0x300-0x3FF 

0x65-0x70 
0xE5-0xF0 
0x165-0x170 
0x1E5-0x1F0 

PIC16F819 0x700-0x7FF 
0x65-0x70 
0xF0, 0x170 
0x1E5-0x1F0 

PIC16F870 
PIC16F871 
PIC16F872 

0x700-0x7FF 

0x70, 0xF0 
0xB5-0xBF 
0x170, 0x1F0 
0x1B5-0x1BF 

PIC16F873/873A 
PIC16F874/874A 0xF00-0xFFF 

0x7E-0x7F 
0xF4-0xFF 
0x17E-0x17F 
0x1F4-0x1FF 

PIC16F876/876A 
PIC16F877/877A 

0x1F00-0x1FFF 
0x70, 0xF0 
0x170, 0x1F0 
0x1E5-0x1EF 

PIC16F882 0x06C0-0x07FF 
0x70, 0xF0 
0x170, 0x1F0 
0x0B5-0x0BF 

PIC16F883/884 0x0F00-0x0FFF 
0x70, 0xF0 
0x170, 0x1F0 
0x165-0x16F 

PIC16F886/887 0x1F00-0x1FFF 
0x70, 0xF0 
0x170, 0x1F0 
0x1E5-0x1EF 

PIC16F913/914 0xF00-0xFFF 
0x70, 0xF0 
0x165-0x16F 
0x170, 0x1F0 
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Tipo 
Memória de Programa 

usada 
Registradores 

usados 

PIC16F916/917 
PIC16F946 

0x1FF0-0x1FFF  

 
 
Recursos utilizados pela família 18F: 
 
Características gerais: 

• Pino MCLR utilizado para depurar. Não poderá utilizar como 
I/O digital no modo depurador. (Exceto para componentes 
ICE); 

• MCLR/VPP livre para gravação; 
• PGC e PGD reservados para modo Depurador. Portanto 

outras funções multiplexadas nestes pinos não estarão 
disponíveis para depurador; 

• Duas pilhas não disponíveis. Pelo motivo do ICD2BR utilizar 
duas pilhas o registrador TOS (TOSL, TOSH, TOSU) estão 
reservados; 

• Modo de programação ICSP baixa voltagem desabilitado; 
 
Tabela de uso: 
 

Tipo 
Memória de Programa 

usada 
Registradores 

Usados 

PIC18C601 
PIC18C801 

0x1FFE00-0x1FFFFF 
(Boot RAM) 

0x3F4-0x3FF 

PIC18F242 
PIC18F248 
PIC18F442 
PIC18F448 

0x3DC0-0x3FFF 0x2F4-0x2FF 

PIC18F252 
PIC18F258 
PIC18F452 
PIC18F458 

0x7DC0-0x7FFF 0x5F4-0x5FF 
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Tipo 
Memória de Programa 

usada 
Registradores 

Usados 

PIC18F1220 0x0E40-0x0FFF 0xF0-0xFF 

PIC18F1230 
PIC18F1231 0xFDC0-0xFFFF 0xFB-0xFF 

PIC18F1320 0x1E40-0x1FFF 0xF0-0xFF 

PIC18F1330 
PIC18F1331 

0x1FDC0-0x1FFFF 0xFB-0xFF 

PIC18F2220/4220 0x0DC0-0x0FFF 

PIC18F2221/4221 0x1DC0-0x1FFF 

PIC18F2320/4320 0x1DC0-0x1FFF 

PIC18F2321/4321 0x0DC0-0x0FFF 

0x1F4-0x1FF 

PIC18F2331/4331 0x1DC0-0x1FFF 0x2F4-0x2FF 

PIC18F2410/4410 
PIC18F2420/4420 
PIC18F2431/4431 

0x3DC0-0x3FFF 0x2F4-0x2FF 

PIC18F2439 0x5F4-0x5FF 

PIC18F4439 
0x3DC0-0x3FFF 

0x2F4-0x2FF 

PIC18F2450/4450 0x3DC0-0x3FFF 0x1F4-0x1FF 

PIC18F2455/4455 0x5DC0-0x5FFF 0x3F4-0x3FF 

PIC18F2458/4458 0x5DC0-0x5FFF 0x3F4-0x3FF 

PIC18F2480/4480 0x3DC0-0x3FFF 0x2F4-0x2FF 

PIC18F2510/4510 0x7DC0-0x7FFF 0x5F4-0x5FF 

PIC18F2515/4515 0xBD80-0xBFFF 0xEF4-0xEFF 

PIC18F2520/4520 0x7DC0-0x7FFF 0x5F4-0x5FF 

PIC18F2525/4525 0xBD80-0xBFFF 0xEF4-0xEFF 

PIC18F2539/4539 0x7DC0-0x7FFF 0x5F4-0x5FF 

PIC18F2550/4550 0x7DC0-0x7FFF 0x3F4-0x3FF 

PIC18F2553/4553 0x7DC0-0x7FFF 0x3F4-0x3FF 

PIC18F2580/4580 0x7DC0-0x7FFF 0x5F4-0x5FF 

PIC18F2585/4585 0xBD80-0xBFFF 0xCF4-0xCFF 
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Tipo 
Memória de Programa 

usada 
Registradores 

Usados 

PIC18F2610/4610 
PIC18F2620/4620 

0xFD80-0xFFFF 0xEF4-0xEFF 

PIC18F2680/4680 0xFD80-0xFFFF 0xCF4-0xCFF 

PIC18F2682/4682 0x13D80-0x13FFF 0xCF4-0xCFF 

PIC18F2685/4685 0x17D80-0x17FFF 0xCF4-0xCFF 

PIC18F6310/8310 
PIC18F6390/8390 

0x1DC0-0x1FFF 0x2F4-0x2FF 

PIC18F6410/8410 
PIC18F6490/8490 0x3DC0-0x3FFF 0x2F4-0x2FF 

PIC18F6520/8520 0x7D80-0x7FFF 0x7F4-0x7FF 

PIC18F6525/8525 0xEF4-0xEFF 

PIC18F6527/8527 0x7F4-0x7FF 

PIC18F6585/8585 

0xBD80-0xBFFF 

0xCF4-0xCFF 

PIC18F6620/8620 

PIC18F6621/8621 

PIC18F6622/8622 

0xFD80-0xFFFF 0xEF4-0xEFF 

PIC18F6627/8627 0x17D80-0x17FFF 0x7F4-0x7FF 

PIC18F6680/8680 0xFD80-0xFFFF 0xCF4-0xCFF 

PIC18F6720/8720 0x1FD80-0x1FFFF 0xEF4-0xEFF 

PIC18F6722/8722 0x1FD80-0x1FFFF 0x7F4-0x7FF 

PIC18F24J10/44J10 
(PIC18F44J10-ICE) 

PIC18F25J10/45J10 
(PIC18F45J10-ICE) 

Nenhum 0x3F4-0x3FF 

PIC18F63J11/83J11 
PIC18F64J11/84J11 
PIC18F63J90/83J90 
PIC18F64J90/84J90 
(PIC18F85J90-ICE) 

Nenhum 0x3F4-0x3FF 
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Tipo 
Memória de Programa 

usada 
Registradores 

usados 

PIC18F65J10/85J10 
PIC18F65J15/85J15 
PIC18F66J10/86J10 
PIC18F65J90/85J90 
(PIC18F87J10-ICE) 

Nenhum 0x7F4-0x7FF 

PIC18F66J60/ 
86J60/96J60 
PIC18F67J60/ 
87J60/97J60 
PIC18F66J65/ 
86J65/96J65 
(PIC18F97J60-ICD) 

Nenhum 0xDF4-0xDFF 

PIC18F65J50/85J50 
PIC18F66J50/86J50 
PIC18F67J50/87J50 
PIC18F66J55/86J55 
PIC18F66J15/86J15 
PIC18F67J10/87J10 
(PIC18F87J10-ICE) 

Nenhum 0xEF4-0xEFF 

PIC18F65J11/85J11  
PIC18F66J11/86J11  
PIC18F67J11/87J11  
PIC18F66J16/86J16  
(PIC18F85J90-ICE) 

Nenhum 0xEF4-0xEFF 

 

 
Recursos utilizados pela família 30F: 
 
Características gerais: 

• Pino MCLR utilizado para depurar. Não poderá utilizar como 
I/O digital no modo depurador; 

• MCLR/VPP livre para gravação; 
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• PGC e PGD reservados para modo Depurador. Portanto 
outras funções multiplexadas nestes pinos não estarão 
disponíveis para debug; 

 

Tipo Memória de Programa 
usada 

Registradores 
usados 

dsPIC30F  Nenhum 0x800-0x822  

 
 
Recursos utilizados pela família 33F e 24F: 
 
Características gerais: 

• Pino MCLR utilizado para depurar. Não poderá utilizar como 
I/O digital no modo depurador; 

• MCLR/VPP livre para gravação; 
• PGC e PGD reservados para modo Depurador. Portanto 

outras funções multiplexadas nestes pinos não estarão 
disponíveis para debug; 

 

Tipo Memória de Programa 
usada 

Registradores 
usados 

PIC24F 
(PIC24F-ICE) 

dsPIC33F 
(dsPIC33F-ICE) 

Nenhum 0x800-0x850 
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2. Instalando o ICD2BR 

2.1. Sistema e componentes requeridos para 
utilizar o ICD2BR 

 

• MPLAB versão 6.20 ou superior. É recomendado instalar o 
MPLAB versão 7.31 (ou superior) que segue no CD; 

• USB – Não instale o cabo USB antes de instalar o MPLAB. 
Siga as instruções de instalação da USB até ser concluído o 
processo. 

• O ICD2BR utilizará o próprio sistema de fonte da USB para 
gravação e depuração. Se o sistema em desenvolvimento 
necessitar de uma corrente acima de 50mA, será necessário o 
desenvolvimento de uma fonte própria para a aplicação 
conforme necessidade. 

 

2.2. Instalando e Configurando o ICD2BR 

 
Após a instalação do MPLAB conecte o cabo USB no micro e no 
ICD2BR. Aparecerá uma janela de instalação de um dispositivo USB. 
Siga as instruções de instalação dos drivers do ICD2BR. Quando 
solicitado o driver para o dispositivo localize-o na pasta de instalação 
do MPLAB o diretório ICD2\Drivers (nas versões do 7.xx do MPLAB) 
ou no diretório Driversnn\ICD2_USB (nas versões 6.xx do MPLAB, 
onde nn é a versão do sistema operacional). Dependendo do sistema 
operacional pode aparecer uma mensagem que o driver não é 
certificado. Ignore esta mensagem e instale normalmente. 
 
Observação: A partir da versão 7.31 do MPLAB existe a possibilidade 
de pré-instalar o driver do ICD2BR durante a instalação do MPLAB, 
facilitando a instalação do ICD2BR. Quando conectado o cabo USB no 
micro e no ICD2BR aparecerá a janela de instalação e esta já 
reconhecerá o ICD2BR, bastando apenas confirmar a instalação dos 
driver. 
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Após instalação do ICD2BR: 
 

• Use o diálogo de seleção (Configure > Select Device) para 
selecionar o componente a ser depurado. Para saber se o 
componente escolhido é suportado pelo ICD2BR como 
Depurador, um marcador ao lado do nome ICD2BR deverá estar 
na cor verde; 

• Habilite o ICD2BR como gravador (Programmer > Select 
Programmer > MPLAB ICD2); 

• Configure o ICD2BR para interface USB (Programmer > 
Settings, item Comunications e selecione a interface USB); 

• No item Programmer > Settings orelha Power configure a fonte 
de alimentação. Se você for usar o ICD2BR com o McSoc 
(somente para PICs de 8 a 40 pinos), selecione a opção Power 
target circuit from MPLAB ICD2. No caso de usar o ICD2BR 
com uma placa de aplicação, ligue a fonte da placa e desabilite 
o item citado acima (Vdd da placa de aplicação deve estar 
ligado no pino Vdd do RJ12 ou CN5). 

2.3. Opções de conexão 

 

Uma vez iniciada a conexão com o ICD2BR, você pode continuar a 
conectar manualmente cada vez que você seleciona o ICD2BR como 
um depurador (use Programmer > Connect) ou você pode setar o 
ICD2BR para conexão automática (use o caminho “Automatically 
connect at start-up” ( Programmer > Settings > orelha Status ). 
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2.4.  Preparando o Ambiente (MPLAB) para 
utilizar o ICD2BR 

 
Segue um guia rápido de operação do ICD2BR 
 
Selecionando o modo depurador e opções de programação 
 
O caminho mais fácil para configurar é utilizando o MPLAB ICD2 
Setup Wizard (Programmer > MPLAB ICD2 Setup Wizard). 
Adicionalmente, estes diálogos permitem você habilitar ou desabilitar 
o modo depurador ou opção de programação: 
 

• Configuração de bits (Configurations Bits): (Configure > 
Configurations Bits). Selecione a configuração de bits do 
componente. Para completar os detalhes sobre estas opções, 
veja as características especiais (Special Features) no 
datasheet do componente a ser programado. 

 
Nota: A configuração de bits pode ser especificada no seu próprio 
código fonte, facilitando o procedimento, além do mais, toda vez que 
seu código é compilado você terá que habilitar suas configurações de 
bits se elas não tiverem no código. 
 

• Habilitando o modo ICD2 (Debugger > Settings ou 
Programmer > Settings).  Escolha a comunicação, a 
alimentação, programação e mensagens de alerta, como 
também o status, limitações e informações.  

 
Você tem que tomar cuidado com a alimentação da placa de 
aplicação em relação ao ICD2BR.  Siga os passos usando o Setup 
Wizard do ICD2BR. Para maiores detalhes utilize a caixa de diálogo 
Settings Dialog: 
 

• Orelha Program – Selecione (memórias, programas, tamanho 
memória externa ID, opção de programação, apagar tudo). Se 
for desejado realizar a programação dos bits do ID, coloque o 
valor a ser programado em Configure > ID Memory ; 
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• Orelha Warnings – Determine cada mensagem de alerta para 
aparecer no MPLAB. Pode ser selecionado para todas as 
mensagens se elas forem repassadas ao arquivo (veja a orelha 
Status); 

• Orelha Status – Em adição a auto conexão na inicialização e 
controle Self Test, as mensagens podem ser selecionadas e 
serem logadas para o arquivo. Estas mensagens podem ajudar 
usuários ou se necessário, o suporte LabTools pode ajudar a 
encontrar os erros. 

 
 
Criando e compilando um Projeto 
 
O caminho mais fácil para criar um projeto novo é selecionando 
Project > Project Wizard. O Project Wizard guiará você para o 
processo de adição de arquivos fonte (source files), bibliotecas 
(libraries), linker scripts, etc. para vários nodes na janela do projeto.  
Depois do projeto criado, escolha Project > Build All para compilar sua 
aplicação. Este código objeto criado para a aplicação pode ser 
programado dentro da placa de aplicação com o ICD2BR. 
 

2.5. Seqüência para desenvolver com ICD2BR 

  

A seqüência para desenvolver com ICD2BR segue estes passos: 
 

2.5.1. Programando o componente para 
depurar: 

Para programar o código fonte dentro do ICD2BR como depurador, 
siga estes passos: 
 

• Selecione Debugger > Settings e clique na orelha Program 
para setar a opção de programação para sua aplicação; 

• Selecione Configure > Configuration Bits e acerte o oscilador e 
outras configurações apropriadas para o componente 
escolhido (se necessário); 
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• Selecione Debugger > Program para download de seu código 
e execute o debug para o componente ou sua placa de 
aplicação conectada no ICD2BR. O tempo de download 
depende da memória utilizada. 

 
Existem ainda algumas dicas antes de depurar: 
 

1. Em Debugger > Settings na orelha Program existem duas 
alternativas na opção Automatically. A primeira Program after 
successful build serve para gravar o programa logo após a 
compilação do programa, se o mesmo não tiver erros. A 
segunda Run after successful program diz ao MPLAB para 
rodar o programa logo após a gravação. 

 
2. Em Debugger > Settings na orelha Program é interessante que 

clique na opção Alow ICD2 to select memories and ranges 
para o ICD2BR automaticamente ajustar o tamanho e quais 
memórias devem ser gravadas. Com isso ganha-se muito na 
velocidade de gravação do código fonte no PIC; 

  
 
 

2.5.2. Seqüência do Depurador 

 

Para depurar seu código, siga estes passos: 
 

• Tempo real de execução (Real Time) 
 
O tempo real de execução ocorre quando o componente na placa de 
aplicação é colocado no modo Run no MPLAB. 
Quando o ICD2BR roda em tempo real, as instruções executam como 
o componente estivesse sem o depurador. Quando no modo Run, os 
registros não são atualizados na tela do MPLAB.  
 
Para executar o código em tempo real, abra o código fonte, selecione 
Debugger > Run. O componente vai rodar até um breakpoint inserido 
ou até o Debugger > Halt.  
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• Breakpoints (pontos de parada) 
 
Breakpoints permite você especificar uma condição de parada de seu 
código, bem como observar a memória, registro ou variação de 
valores depois de uma execução em tempo real. Você pode inserir o 
breakpoint na janela do código-fonte ou na janela View > Program 
Memory. 
Você pode inserir um breakpoint utilizando simultaneamente: 
 

► Botão da direita de seu mouse, clique na linha do código 
que você deseja inserir um breakpoint; 

► Diálogo do breakpoint – Debugger > Breakpoints e entre 
com um breakpoint em um endereço específico; 

► Clicando duas vezes no lugar onde deseja inserir um 
breakpoint. 

 
• Modo de execução passo a passo: 

 

O modo de execução passo a passo pode ser 
acessado depois da parada do processador.  

Esta execução ocorre em um único passo no 
processador ou execute Debugger > Step Into. Este 
modo permite realizar uma instrução por tempo, para 
ver o fluxo do programa e visualizar os registradores. 

Nota: Quando operar neste modo o ICD2BR não 
responde o depurador nas interrupções. 

• Escrevendo na memória EEPROM ou na memória de 
programa (FLASH) 

 

Se a EEPROM ou a memória de programa está 
sendo escrita durante a execução do programa, a 
janela EEPROM do MPLAB e a janela Program 
Memory não mostra as mudanças. Você precisará ler 
o código fonte (Debugger > Read) para que os 
valores da EEPROM e a memória de programa sejam 
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atualizados. Se alguma posição da memória de 
programa ou algum valor na memória de dados não 
aparecem corretos, lembre-se que o ICD2BR reserva 
recursos para que o modo Depurador funcione. 

2.5.3. Modificação do código para depurar 

• Abra o código fonte (dê um duplo clique no arquivo 
escolhido dentro da janela de projeto ou use File > 
Open); 

• Inserir na linha de configuração de bits para gravação 
a opção _DEBUG_ON (em assembly). Para outras 
linguagens de programação consulte o manual do seu 
compilador; 

• Desabilite o Watchdog Timer na linha de configuração 
de bits com a opção _WDT_OFF; 

• Comente as linhas de códigos que podem usar algum 
recurso do Watchdog Timer; 

• Recompile o arquivo usando Project > Buid All; 

• Selecione Debugger > Program para programar o 
componente com o arquivo.hex modificado. 

Exemplos de códigos preparados para modo de depuração, 
vide página 51, apêndice I. 

2.5.4. Terminando o depurador e utilizando o 
ICD2BR como gravador. 

 

Uma vez que o código tenha sido depurado e a aplicação rodada 
como projeto, o componente pode ser programado com o depurador 
desabilitado. Os recursos do componente reservados para a operação 
do ICD2BR estarão livres para outro uso. O ICD2BR pode ser 
selecionado como depurador ou gravador, nunca os dois juntos. 
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Antes de gravar o seu código você deve modificar para gravação - 
mudar o _DEBUG_ON para _DEBUG_OFF (em assembly) e habilitar 
o Watchdog Timer, se necessário. 
 
Para mudar o ICD2BR do modo depurador para gravador faça o 
seguinte: 
 
Clique em Debugger > Select Tool >MPLAB ICD2 e selecione 
Nenhum para desabilitar o ICD2BR como Depurador. 
Após isso clique em Programmer > Select Programmer > MPLAB 
ICD2 para habilitar o ICD2BR como gravador; 
 
O menu do gravador e o MPLAB mudarão para opções de gravação 
sempre que a ferramenta for selecionada. Também, a janela de saída 
(output) abrirá mensagens sobre o status de comunicação e aceitação 
do ICD. 
O projeto recompilado com os bits de configuração (Configurations 
Bits) inseridos no código fonte podem ser gravados no componente. 
Verifique como a sua fonte está habilitada. Para gravar a aplicação do 
projeto no componente siga os passos: 
 
 

• Selecione Programmer > Settings e clique na orelha Program 
para setar a opção de programação para sua aplicação; 

• Configuração de bits para gravação estará inserida conforme 
escrita em seu código fonte; 

• Selecione Configure > Configuration Bits e acerte o oscilador e 
outras configurações apropriadas para o componente 
escolhido (se necessário); 

• Se desejar, configure os bits de identificação (ID) selecionando 
Configure > ID Memory; 

• Selecione Programmer > Blank Check para checar se o 
componente esta apagado. Se não estiver, é obrigatório o 
processo de apagar (Programmer > Erase Part); 

• Selecione Programmer > Program para inserir seu código no 
componente ou placa de aplicação ou placa de demonstração 
que está conectada no seu ICD2BR.  
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2.5.5. Opções adicionais do modo gravação 

Como um programador o ICD2BR têm as funções tradicionais 
de funcionamento como outro produto LabTools (McPlus PIC 
por exemplo). 

Seguem: 

Verificação da programação  

Selecione Verify do menu de gravação para verificar se o 
componente foi gravado corretamente.    

Lendo um componente 

Selecione Read do menu de gravação para ler a memória de 
programa e a EEPROM interna. 

Ler a memória do componente usando o MPLAB pode ser 
salvo em um arquivo. Para salvar clique em File > Export.  

Se você tentar ler um componente com código de proteção 
(code protection) não conseguirá obter sucesso. 

Apagar e verificar se um componente está apagado 

Erase Part - Selecione este item para apagar a memória de 
programa. O oscilador interno os bits de calibração sempre 
são preservados pelo ICD2BR. 

Blank Check – Selecione Blank Check para verificar que o 
componente está apagado. 
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3. Limitações do ICD2BR 
Limitações de depuração 

• O ICD2BR usa recursos dos componentes, quando está 
depurando.Se você modificar a memória de programa, 
você terá que compilar o programa todo novamente. 

• O comando de Reset volta sempre pra zero e pára. O 
programa não volta ao lugar de origem da depuração 
automaticamente. 

• Limite de breakpoints disponíveis: Dependendo do 
microcontrolador uma determinada quantidade de 
breakpoints está disponível ao usar o ICD2BR. 

• O número real varia dependendo do dispositivo 
selecionado. Para ver qual o limite de breakpoints que 
você pode usar, selecione limites de breakpoints do 
Depurador para ver "o limite ativo de breakpoints" na 
caixa de diálogo. 

• Podem ocorrer derrapagens em breakpoints. 

Os limites de breakpoints podem “derrapar” (não parar na 
instrução aonde o breakpoint é colocado), baseado no 
dispositivo e no tipo de memória em que são ajustados, como 
descrito abaixo: 

Números de instruções “derrapadas” 
Família 

Memória de programa Memória de dados 

PIC12/16 1 0 

PIC18  1  2  

dsPIC30F  2 2 
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• A velocidade de clock na barra de status não é 
relevante. A velocidade de clock é ajustada pelo 
oscilador do componente; não é controlada ou medida 
pelo MPLAB. 

• Você não pode executar um único passo através da 
interrupção. 

• A instrução SLEEP não pode ser usada quando você 
está depurando. (Alguns componentes suportam 
“Break on Sleep” que podem trabalhar em volta desta 
limitação); 

• O Watchdog Timer (WDT) não pode ser usado quando 
você está depurando. 

• Você não pode ver a pilha (stack) mesmo que você 
possa acessá-la; 

• Se você tentar em um único passo depurar uma 
instrução inválida, o contador de programa (program 
counter) move-se para a posição 2A. 

 

Limitações de gravação 

• Um cuidado deve ser tomado ao programar 
microcontroladores (gravação in-circuit) com a opção 
PLL. O PLL muda somente quando a alimentação é 
aplicada pela primeira vez no componente. Se você 
estiver programando o PLL pela a primeira vez, 
remova a alimentação do microcontrolador e após a 
programação, reaplique-a para que o PLL seja 
habilitado. Se você reprogramar o dispositivo da 
modalidade PLL a uma outra modalidade, 
primeiramente reprograme com PLL fora, em seguida, 
remova a alimentação e reaplique-a; 
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• Para todos os componentes com memória EEPROM, 
a operação de Erase (apagar) também apaga a 
EEPROM. 

• No modo de depuração os pinos Clock e Data não 
funcionam com o hardware da placa. 

Depurando com agilidade 

Quando você seleciona o MPLAB ICD2 (ICD2BR) no menu 
Debugger, os itens para depurar são adicionados seguindo as 
funções do MPLAB: 

► Run - F9 

Executa o código até um breakpoint ou até Halt ser 
selecionado. A execução começa no contador de programa 
atual (como indicado na barra de status). A posição do 
contador de programa atual é representada também como um 
ponteiro na janela da memória do programa. Quando o 
programa funcionar, diversas outras funções são 
desabilitadas. 

► Animate 

 O modo Animate atualiza os valores dos registros. O 
funcionamento do Animate é mais lento do que a função Run, 
mas permite que você veja os valores mudando tanto no 
registro quanto na janela do clock. Para parar o Animate, use a 
parada do Depurador no menu opção F5. 

► Halt - F5  

A função Halt pára a execução do código. Quando você clica 
em Halt, as informações dos registradores são atualizadas. 
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► Step Into - F7 

Função passo a passo no código de programa 

Este comando executa uma instrução. Após a execução de 
uma instrução, todas as janelas são atualizadas. Para o 
código em C, este comando executa uma linha, que pode 
significar e execução de um ou mais instruções. Após a 
execução todas as janelas também são atualizadas em C. 

► Step Over - F8  

Não disponivel no ICD2BR.  

► Step Out  

Não disponível no ICD2BR.  

► Reset - F6 

Realizar uma seqüência de Reset (restauração) emite um 
MCLR para restaurar o Program Counter ao vetor de Reset. 
Se o componente está rodando, e é acionado o F6 o 
programa continuará rodando, porém, a partir do endereço de 
vetor de Reset. 

► Breakpoints - F2  

Abra a caixa de diálogo do breakpoint. Ajuste os múltiplos, 
entretanto, somente um breakpoint é permitido em um 
momento. Você pode também utilizar o botão da direita e 
ajustar seu breakpoint. 

► Advanced Breakpoints  

Os breakpoints avançados abrem a caixa de diálogo e 
preparam as características avançadas do breakpoint para os 
componentes ICD que suportam tais características. 
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► MPLAB ICD 2 Setup Wizard  

Utilize o Wizard para lhe ajudar a configurar seu ICD2BR. 
(MPLAB ICD2). 

► Program 

Grave seu código na sua placa de aplicação. 

► Read  

Ler seu código fonte gravado em seu componente. Se este 
estiver protegido contra leitura, você não conseguirá ler o 
componente. 

► Abort Operation  

Abortar toda a operação de programação (por exemplo, o 
programa, a leitura). Esta operação deixará o componente em 
um estado desconhecido. 

► Connect  

Estabelecer comunicação entre o MPLAB e o ICD2BR em seu 
PC. 

► Download ICD2 Operating System  

Download da operação de sistema do ICD2BR. 

⇒ Menu botão direito do mouse 

► Set/Remove Breakpoint  

Insira ou remova um breakpoint. 

► Enable/Disable Breakpoint  

Habilite ou desabilite um breakpoint na linha selecionada.  
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► Breakpoints  

Remova, habilite ou desabilite todos os breakpoints.  

► Run To Cursor  

Rode o programa até a posição do cursor atual. 

► Set PC at Cursor  

Ajuste o contador de programa (Program Counter) à posição 
do cursor. 
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4. Apêndice A - Problemas mais comuns 
 

1. O MPLAB não reconhece o ICD2BR ou perda de comunicação 
do ICD2BR com o MPLAB: 

 
Quando ocorrer o erro acima, na janela de Output do MPLAB 
aparecerá: 
 
ICD0018: Communications: Failed to set port parameters… 
ICD0021: Unable to connect with MPLAB ICD 2 
MPLAB ICD 2 Ready 
 
ou 
 
ICD0019: Communications: Failed to open port… 
ICD0021: Unable to connect with MPLAB ICD 2 
MPLAB ICD 2 Ready 
 
ou 
 
ICD0020: Communications: Failed to close port… 
ICD0021: Unable to connect with MPLAB ICD 2 
MPLAB ICD 2 Ready 

 
Neste caso, segue um procedimento de correção deste erro: 

 
► Vá em Programmer > Select Programmer e selecione None; 
► Retire o cabo USB no ICD2BR, aguarde o Windows indicar que 

desconectou (através de um sinal sonoro no Windows XP, por 
exemplo) e conecte novamente. 

► Aguarde o Windows indicar que conectou (através de um sinal 
sonoro no Windows XP, por exemplo) e clique em 
Programmer > Select Programmer e selecione MPLAB ICD2. 
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2. O ICD2BR não depura nas placas McLab1 e McLab2: 
 
► Vá em Debugger > Settings orelha Power e selecione a opção 

Power target circuit from ICD2; 
► Verificar se foram feitas as modificações para a depuração. 

Consulte a página 31, item 2.5.3; 
 

3. Quando se faz uma gravação in circuit o programa não roda: 
 
► Clique em Programmer > Settings orelha Program e selecione 

a opção Run After Successful Program. Na versão 6.xx do 
MPLAB não existe esta opção, sendo necessário a retirada do 
cabo de gravação in circuit. 

 
4. Os pinos usados na gravação in circuit, quando usados para 

outras funções não são liberados após a gravação: 
 
► Após a gravação in circuit deve ser retirado o cabo RJ12 para 

que os pinos funcionem corretamente. 
 

5. O ICD2BR não consegue comunicar com a placa na hora de 
depurar na placa de aplicação: 

 
Quando ocorrer o erro acima, na janela de Output do MPLAB 
aparecerá: 
 

ICD0083: Debug: Unable to enter debug mode. 
 
► Verifique se o programa está preparado para depuração; 
► Verifique se foi gravado o programa antes de depurar 

(Debugger > Program); 
► Verifique se o microcontrolador selecionado possui opção de 

depuração (vide página 5 tabela item 1.3). 
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6. O ICD2BR não consegue detectar o microcontrolador após 
conectar com o MPLAB: 

 
Quando ocorrer o erro acima, na janela de Output do MPLAB 
aparecerá: 
 

ICDWarn0020: Invalid target device id… 
 
► Verifique se o microcontrolador está devidamente conectado 

ao ICD2BR (PGC, PGD, MCLR, Vdd e Vss); 
► Verifique se todos os pinos de alimentação (Vdd, Vss, AVdd, 

AVss) e capacitores (atenção especial aos dispositivos de 3,3V 
– microcontroladores PIC18 série J, dsPIC33F e PIC24F e 
PIC24H) estão devidamente conectados; 

► Se estiver usando o McSoc, clique em Programmer > Settings 
orelha Power marque a opção Power target circuit from MPLAB 
ICD2. Note que o McSoc não grava PIC10F, dsPIC’s, PIC18 
série J, PIC24F e PIC24H; 

► Verifique se o microcontrolador a ser gravado está 
devidamente selecionado no Configure > Select Device; 

 
7. Quando programo um microcontrolador configurado com 

oscilador interno e MCLR interno aparece a mensagem 
ICDWarn0033: 

 
Quando um microcontrolador é programado com a opção do oscilador 
interno e o MCLR interno habilitados ao mesmo tempo, o MPLAB 
avisa que se o programa fizer uso dos pinos PGD e PGC e após a 
gravação do microcontrolador o programa irá rodar e se o ICD2BR 
ainda enviar dados ao microcontrolador poderá ocorrer à queima dos 
pinos PGC e PGD, impossibitando assim uma nova gravação. 
Um delay de 10ms deve ser inserido no início do programa para evitar 
este problema. 
Em alguns casos quando aparece a mensagem ICDWarn0033 pode 
aparecer uma mensagem ICD0200: Operation Aborted e após isso 
não é efetuada a gravação do programa. Para resolver este problema, 
clique em Programmer > Settings orelha Warnings e selecione a 
opção ICDWarn0033... 
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5. Apêndice B - Cabo de ligação entre 
ICD2BR e produtos LabTools 

 
A tabela a seguir mostra como montar um cabo para ligação entre o 
ICD2BR e os produtos LabTools. O conector utilizado é do tipo RJ12 
nas duas extremidades. 
Obs: Olhando o conector de frente, com a trava para baixo, o pino 1 é 
o da direita! 
 

ICD2BR – RJ12 (Labtools) Produtos LabTools – RJ12 
Pino Função Pino Função 

1 Não usado 6 Não usado 

2 Vss 5 Vss 
3 Vdd 4 Vdd 
4 PGC 3 PGC 
5 PGD 2 PGD 
6 Vpp 1 Vpp 
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6. Apêndice C - Cabo de ligação entre 
ICD2BR e produtos Microchip 

A tabela a seguir mostra como montar um cabo para ligação entre o 
ICD2BR e os produtos Microchip. O conector utilizado é do tipo RJ12 
nas duas extremidades. 
 

ICD2BR – RJ12 (Microchip) Produtos Microchip – RJ12 
Pino Função Pino Função 

1 Não usado 6 Não usado 

2 PGC 5 PGC 
3 PGD 4 PGD 
4 Vss 3 Vss 
5 Vdd 2 Vdd 
6 Vpp 1 Vpp 

 

 

 

 

 

 
 

 

 

 

 

 



 

45 

ICD2
BR

 Guia do Usuário

7. Apêndice D – Pinagem do conector 
Header ICD2BR 

 
A tabela a seguir mostra a pinagem do conector Header (CN5) 
disponível para montagem de um cabo ICSP. 
 

ICD2BR – Conector Header (CN5) 
Pino Função 

1 Não usado 

2 Vss 
3 Vdd 
4 PGC 
5 PGD 
6 Vpp 
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8. Apêndice E – Gravação In-Circuit 
 

Para utilizar o ICD2BR em modo de gravação in-circuit você deve montar 
um cabo conforme a tabela a seguir: 

 

ICD2BR – RJ12 (LabTools) Microcontrolador PIC a ser 
gravado 

Pino Função Pino no PIC 
1 Não usado Não usado 
2 Vss Vss (GND) 
3 Vdd Vdd (Vcc) 
4 PGC PGC 
5 PGD PGD 
6 Vpp MCLR 

 

Deve-se tomar cuidado com os níveis de tensão envolvidos na 
gravação. O PIC a ser gravado deve estar previamente energizado 
antes de iniciar a gravação, ou seja, a própria placa onde o PIC que 
será gravado se encontra deverá estar energizada. O ICD2BR não tem 
capacidade de corrente suficiente para alimentar o PIC que está 
sendo gravado e o resto do circuito que se encontra na placa, por este 
motivo, a própria placa deve prover alimentação ao PIC a ser gravado 
e não o ICD2BR.   
O sinal ligado ao pino MCLR do microcontrolador atingirá uma tensão 
de 13V aproximadamente durante a gravação, por este motivo, o PIC 
a ser gravado in-circuit não pode estar com o MCLR ligado 
diretamente ao +5V. Recomendamos o uso de um resistor de 10KΩ 
ligando o MCLR ao +5V, de forma que a tensão de gravação (+13V) 
possa ser aplicada ao pino MCLR sem problemas. 
Quanto aos pinos PGC (clock) e PGD (data) utilizados pela gravação, 
deve-se observar o sentido de corrente em relação ao circuito já presente 
na placa. O ideal é isolar o circuito da placa do circuito de gravação 
através de dois resistores de pelo menos 1kΩ. A localização dos pinos 
correspondente ao clock, data e MCLR depende do microcontrolador 
usado. Verifique esta informação no datasheet do componente usado. 
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A figura abaixo ilustra a forma de conectar o gravador ao PIC para 
gravação in-circuit. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

Para o circuito mostrado acima, não esqueça de clicar em 
Programmer > Settings orelha Power e marque a opção Power target 
circuit from MPLAB ICD2. 
 

 

 

 

 

 

 

 

 

 

 

PGC 

PGD 

Vpp 

1kΩ 

1kΩ 

10kΩ 

+5V 

PIC 
 
/MCLR 
 
 
PGD 
 
PGC 

ao circuito da placa 

ao ICD2BR 

GND 
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9. Apêndice F – Gravação de 
microcontroladores alimentados com 
3,3V 

 

Os novos microcontroladores PIC (PIC18 série J, dsPIC33F, 
PIC24F e PIC24H) a tensão máxima de alimentação destes 
componentes é de 3,3V e por este motivo modelos DIP destes 
componentes não podem ser gravados no soquete de gravação, tanto 
o que acompanha o ICD2BR quanto o soquete para gravação de 
dsPICs. 

A gravação destes componentes deve ser apenas in-circuit, como 
mostra a figura abaixo: 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 
No MPLAB clique em Programmer > Settings orelha Power e 

desmarque a opção Power target circuit from MPLAB ICD2. 

1kΩ 1kΩ 

10kΩ 

+3,3V 

PGC 

PGD 

Vpp 

PIC ou dsPIC 
 
/MCLR 
 
 
PGD 
 
PGC 

ao circuito da placa 

ao ICD2BR 

GND 

+3,3V 

Vdd 
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10. Apêndice G - Disposição dos Pinos no 
Conector RJ12 

 
Vista pelo lado da solda: 

 
Vista frontal: 
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11. Apêndice H – Posição do Jumper no 
Soquete para Gravação dos Pic’s 

 
O desenho a seguir mostra como gravar os modelos de PIC. A posição do 
pino 1 deve obedecer o desenho impresso no soquete, conforme pinagem 
do PIC. Todos os McSoc’s saem de fábrica com a configuração para 
gravação em PIC’s de 8, 14 e 18 pinos. Para gravação dos modelos de 8, 
14 e 18 pinos (DIP) coloque os jumpers na posição A, para os modelos de 
28 e 40 pinos (DIP) coloque os jumpers na posição B. Salientamos que 
este soquete não pode ser utilizado com dsPIC, PIC24 PIC18 série J e 
PIC24. 
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12. Apêndice I - Exemplos de códigos para 
modo de depuração 

 

PIC16F877A 
 
Circuito de teste: 
 

+5V 5V

5V

PGC
PGD
MCLR

U1
PIC16F877A

39
40

111
32

12
31

33

34

13

14

RB6/PGC
RB7/PGD

MCLR/VppVdd
Vdd

Vss
Vss

RB0

RB1

OSC1

OSC2

HEADER - ICSP
LIGAR AO CN5 DO ICD2BR

1
2
3
4
5
6

XTAL1
4MHz

C1
22pF

C2
22pF

R3
10k

R2
330R

LED BOTÃO

R1
10k

 
 
Exemplo em Assembly: 
 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
; *                   LABTOOLS - MOSAICO DIDACTIC DIVISION                  * 
; *                                                                         * 
; *  TEL: (0XX11) 4992-8775               SITE: www.labtools.com.br         * 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
; *   VERSÃO : 1.0                                                          * 
; *     DATA : 18/12/2006                                                   * 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
; *                             DESCRIÇÃO GERAL                             * 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
; 
;  TESTE MODO DE DEPURAÇÃO DO ICD2BR - ASSEMBLY 
; 
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; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
; *                DEFINIÇÃO DAS VARIÁVEIS INTERNAS DO PIC                  * 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
;  O ARQUIVO DE DEFINIÇÕES DO PIC UTILIZADO DEVE SER REFERENCIADO PARA QUE 
;  OS NOMES DEFINIDOS PELA MICROCHIP POSSAM SER UTILIZADOS, SEM A NECESSIDADE 
;  DE REDIGITAÇÃO. 
 
 #INCLUDE <P16F877A.INC>  ; MICROCONTROLADOR UTILIZADO 
 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
; *                         CONFIGURAÇÕES PARA GRAVAÇÃO                     * 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 
 __CONFIG _CP_OFF & _CPD_OFF & _DEBUG_ON & _LVP_OFF & _WRT_OFF & _BODEN_OFF & _PWRTE_ON 
& _WDT_OFF & _XT_OSC 
 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
; *                            DEFINIÇÃO DAS VARIÁVEIS                      * 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 CBLOCK 0X20 
 
  TESTE 
 
 ENDC 
 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
; *                      DEFINIÇÃO DOS BANCOS DE RAM                        * 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
;  OS PSEUDOS-COMANDOS "BANK0" E "BANK1", AQUI DEFINIDOS, AJUDAM A COMUTAR 
;  ENTRE OS BANCOS DE MEMÓRIA. 
 
#DEFINE BANK1 BSF STATUS,RP0  ; SELECIONA BANK1 DA MEMORIA RAM 
#DEFINE BANK0 BCF STATUS,RP0  ; SELECIONA BANK0 DA MEMORIA RAM 
 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
; *                           CONSTANTES INTERNAS                           * 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
;  A DEFINIÇÃO DE CONSTANTES FACILITA A PROGRAMAÇÃO E A MANUTENÇÃO. 
 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
; *                    DECLARAÇÃO DOS FLAGs DE SOFTWARE                     * 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
;  A DEFINIÇÃO DE FLAGs AJUDA NA PROGRAMAÇÃO E ECONOMIZA MEMÓRIA RAM. 
 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
; *                                ENTRADAS                                 * 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
;  AS ENTRADAS DEVEM SER ASSOCIADAS A NOMES PARA FACILITAR A PROGRAMAÇÃO E 
;  FUTURAS ALTERAÇÕES DO HARDWARE. 
 
#DEFINE BOTAO  PORTB,0 ; BOTÃO 
    ; 1 -> LIBERADO 
    ; 0 -> PRESSIONADO 
 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
; *                                 SAÍDAS                                  * 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
;  AS SAÍDAS DEVEM SER ASSOCIADAS A NOMES PARA FACILITAR A PROGRAMAÇÃO E 
;  FUTURAS ALTERAÇÕES DO HARDWARE. 
 
#DEFINE LED  PORTB,1 ; LED 
    ; 1 -> LED LIGADO 
    ; 0 -> LED DESLIGADO 
 
 



 

53 

ICD2
BR

 Guia do Usuário

; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
; *                   VETOR DE RESET DO MICROCONTROLADOR                    * 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
;  POSIÇÃO INICIAL PARA EXECUÇÃO DO PROGRAMA 
 
 ORG 0X0000  ; ENDEREÇO DO VETOR DE RESET 
 GOTO CONFIGURACAO ; PULA PARA CONFIG DEVIDO A REGIÃO 
    ; DESTINADA ÀS INTERRUPÇÕES 
 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
; *                VETOR DE INTERRUPÇÃO DO MICROCONTROLADOR                 * 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
;  POSIÇÃO DE DESVIO DO PROGRAMA QUANDO UMA INTERRUPÇÃO ACONTECE 
 
 ORG 0X0004   ; ENDEREÇO DO VETOR DE INTERRUPÇÃO 
 RETFIE    ; RETORNA DA INTERRUPÇÃO 
 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
; *                CONFIGURAÇÕES INICIAIS DE HARDWARE E SOFTWARE            * 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
;  NESTA ROTINA SÃO INICIALIZADAS AS PORTAS DE I/O DO MICROCONTROLADOR E AS 
;  CONFIGURAÇÕES DOS REGISTRADORES ESPECIAIS (SFR).  
 
CONFIGURACAO 
 CLRF PORTA   ; GARANTE TODAS AS SAÍDAS EM ZERO 
 CLRF PORTB 
 CLRF PORTC 
 CLRF PORTD 
 CLRF PORTE 
 
 BANK1    ; SELECIONA BANCO 1 DA RAM 
 
 MOVLW B'11111111' 
 MOVWF TRISA   ; CONFIGURA I/O DO PORTA 
 
 MOVLW B'11111101' 
 MOVWF TRISB   ; CONFIGURA I/O DO PORTB 
 
 MOVLW B'11111111' 
 MOVWF TRISC   ; CONFIGURA I/O DO PORTC 
 
 MOVLW B'11111111' 
 MOVWF TRISD   ; CONFIGURA I/O DO PORTD 
 
 MOVLW B'00000111' 
 MOVWF TRISE   ; CONFIGURA I/O DO PORTE 
 
 MOVLW B'00000000'   
 MOVWF INTCON   ; CONFIGURA INTERRUPÇÕES 
     ; DESABILITA AS INT. 
 MOVLW B'00000111' 
 MOVWF ADCON1   ; CONFIGURA CONVERSOR A/D 
     ; CONFIGURA PORTA E PORTE COMO I/O 
DIGITAL 
 
 BANK0    ; SELECIONA BANCO 0 DA RAM 
 
  
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
; *                              LOOP PRINCIPAL                             * 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
;  ESTA ROTINA PRINCIPAL SIMPLESMENTE LIMPA O WDT, POIS TODA A LÓGICA DO 
;  PROGRAMA É TRATADA DENTRO DAS INTERRUPÇÕES.  
 
MAIN 
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 INCF TESTE,F  ;INCREMENTA VARIÁVEL TESTE 
 
 BTFSC BOTAO  ;O BOTÃO ESTÁ PRESSIONADO? 
 GOTO BOTAO_LIB ;NÃO, ENTÃO TRATA BOTÃO LIBERADO 
 GOTO BOTAO_PRES ;SIM, ENTÃO TRATA BOTÃO PRESSIONADO 
 
BOTAO_LIB 
 BCF LED  ;APAGA O LED 
 GOTO  MAIN  ;RETORNA AO LOOP PRINCIPAL 
 
BOTAO_PRES 
 BSF LED  ;ACENDE O LED 
 GOTO  MAIN  ;RETORNA AO LOOP PRINCIPAL 
 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
; *                              FIM DO PROGRAMA                            * 
; * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 
 END    ; FIM DO PROGRAMA 

 
Exemplo em linguagem C – CCS: 
 
 /* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
  *                   LABTOOLS - MOSAICO DIDACTIC DIVISION                  * 
  *                                                                         * 
  *  TEL: (0XX11) 4992-8775               SITE: www.labtools.com.br         * 
  * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
  *   VERSÃO : 1.0                                                          * 
  *     DATA : 18/12/2006                                                   * 
  * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
 /* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
  *                             DESCRIÇÃO GERAL                             * 
  * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
  
 /* TESTE MODO DE DEPURAÇÃO DO ICD2BR - CCS*/ 
  
 /* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
  *                DEFINIÇÃO DAS VARIÁVEIS INTERNAS DO PIC                  * 
  * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
  
 /* O ARQUIVO DE DEFINIÇÕES DO PIC UTILIZADO DEVE SER REFERENCIADO PARA QUE 
    OS NOMES DEFINIDOS PELA MICROCHIP POSSAM SER UTILIZADOS, SEM A NECESSIDADE 
    DE REDIGITAÇÃO. */ 
  
#include <16f877A.h> 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                         Configurações para gravação                   * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
#fuses XT,NOWDT,NOPROTECT,PUT,BROWNOUT,NOLVP,NOCPD,NOWRT,DEBUG 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                           Constantes internas                         * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
#use fast_io(a)   //MODO RÁPIDO DE MANIPULAÇÃO DOS I/O´s 
#use fast_io(b) 
#use fast_io(c) 
#use fast_io(d) 
#use fast_io(e) 
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#byte PORTA = 0x05  //DEFINIÇÃO DO REGISTRADOR PORTA 
#byte PORTB = 0x06  //DEFINIÇÃO DO REGISTRADOR PORTB 
#byte PORTC = 0x07  //DEFINIÇÃO DO REGISTRADOR PORTC 
#byte PORTD = 0x08  //DEFINIÇÃO DO REGISTRADOR PORTD 
#byte PORTE = 0x09  //DEFINIÇÃO DO REGISTRADOR PORTE 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *              Definição e inicialização das variáveis globais          * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
char TESTE; 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                       PROTOTIPAGEM DE FUNÇÕES                         * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                                ENTRADAS                               * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
// AS ENTRADAS DEVEM SER ASSOCIADAS A NOMES PARA FACILITAR A PROGRAMAÇÃO E 
//FUTURAS ALTERAÇÕES DO HARDWARE. 
 
#bit BOTAO = PORTB.0 //BOTÃO 
   //1 -> PRESSIONADO 
   //0 -> LIBERADO 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                                 SAÍDAS                              * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
// AS SAÍDAS DEVEM SER ASSOCIADAS A NOMES PARA FACILITAR A PROGRAMAÇÃO E 
//FUTURAS ALTERAÇÕES DO HARDWARE. 
 
#bit LED = PORTB.1 //LED 
   //1 -> LIGADO 
   //0 -> DESLIGADO 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                         BLOCO DE FUNÇÕES                            * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                      BLOCO DE FUNÇÕES - ISR                         * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                         FUNÇÃO PRINCIPAL                            * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
void main(void) 
{ 
 PORTA=0x00;  // limpa PORTA 
 PORTB=0x00;  // limpa PORTB 
 PORTC=0x00;  // limpa PORTC 
 PORTD=0x00;  // limpa PORTD 
 PORTE=0x00;  // limpa PORTE 
  
 set_tris_a(0b11111111); //CONFIGURA DIREÇÃO DOS I/O´s 
 set_tris_b(0b11111101); 
 set_tris_c(0b11111111); 
 set_tris_d(0b11111111); 
 set_tris_e(0b00000111); 
 
 while(1) 
 { 
     TESTE = TESTE + 1; //INCREMANTA VARIÁVEL TESTE 
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     if(!BOTAO) LED = 1; //TESTA BOTÃO. SE PRESSIONADO LED = 1; 
     else LED = 0;  //CASO CONTRÁRIO, LED = 0; 
 } 
} 

 
PIC18F452 
 
Circuito de teste: 
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Exemplo C18: 
 
 /* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
  *                   LABTOOLS - MOSAICO DIDACTIC DIVISION                  * 
  *                                                                         * 
  *  TEL: (0XX11) 4992-8775               SITE: www.labtools.com.br         * 
  * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
  *   VERSÃO : 1.0                                                          * 
  *     DATA : 18/12/2006                                                   * 
  * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
 /* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
  *                             DESCRIÇÃO GERAL                             * 
  * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
  
 /* TESTE MODO DE DEPURAÇÃO DO ICD2BR - C18*/ 
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 /* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
  *                DEFINIÇÃO DAS VARIÁVEIS INTERNAS DO PIC                  * 
  * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
  
 /* O ARQUIVO DE DEFINIÇÕES DO PIC UTILIZADO DEVE SER REFERENCIADO PARA QUE 
    OS NOMES DEFINIDOS PELA MICROCHIP POSSAM SER UTILIZADOS, SEM A NECESSIDADE 
    DE REDIGITAÇÃO. */ 
  
#include <p18F452.h> 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                         Configurações para gravação                   * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
#pragma config OSC = XT 
#pragma config WDT = OFF 
#pragma config LVP = OFF 
#pragma config PWRT = ON 
#pragma config BOR = ON 
#pragma config BORV = 45 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                           Constantes internas                         * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *              Definição e inicialização das variáveis globais          * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
unsigned char TESTE; 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                       PROTOTIPAGEM DE FUNÇÕES                         * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                                ENTRADAS                               * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
// AS ENTRADAS DEVEM SER ASSOCIADAS A NOMES PARA FACILITAR A PROGRAMAÇÃO E 
//FUTURAS ALTERAÇÕES DO HARDWARE. 
 
#define BOTAO PORTBbits.RB0 //BOTÃO 
    //1 -> PRESSIONADO 
    //0 -> LIBERADO 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                                 SAÍDAS                              * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
// AS SAÍDAS DEVEM SER ASSOCIADAS A NOMES PARA FACILITAR A PROGRAMAÇÃO E 
//FUTURAS ALTERAÇÕES DO HARDWARE. 
 
#define LED PORTBbits.RB1 //LED 
    //1 -> LIGADO 
    //0 -> DESLIGADO 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                         BLOCO DE FUNÇÕES                            * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                      BLOCO DE FUNÇÕES - ISR                         * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
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/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                         FUNÇÃO PRINCIPAL                            * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
void main(void) 
{ 
 PORTA=0x00;  // limpa PORTA 
 PORTB=0x00;  // limpa PORTB 
 PORTC=0x00;  // limpa PORTC 
 PORTD=0x00;  // limpa PORTD 
 PORTE=0x00;  // limpa PORTE 
  
 TRISA = 0b11111111;  //CONFIGURA DIREÇÃO DOS I/O´s 
 TRISB = 0b11111101; 
 TRISC = 0b11111111; 
 TRISD = 0b11111111; 
 TRISE = 0b11111111; 
 
 while(1) 
 { 
     TESTE = TESTE + 1; //INCREMANTA VARIÁVEL TESTE 
     if(!BOTAO) LED = 1; //TESTA BOTÃO. SE PRESSIONADO LED = 1; 
     else LED = 0;  //CASO CONTRÁRIO, LED = 0; 
 } 
} 
 

dsPIC30F3014 
 
Circuito de teste: 
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Exemplo C30: 
 
 /* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
  *                   LABTOOLS - MOSAICO DIDACTIC DIVISION                  * 
  *                                                                         * 
  *  TEL: (0XX11) 4992-8775               SITE: www.labtools.com.br         * 
  * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
  *   VERSÃO : 1.0                                                          * 
  *     DATA : 18/12/2006                                                   * 
  * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
 /* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
  *                             DESCRIÇÃO GERAL                             * 
  * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
  
 /* TESTE MODO DE DEPURAÇÃO DO ICD2BR - C30*/ 
  
 /* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
  *                DEFINIÇÃO DAS VARIÁVEIS INTERNAS DO PIC                  * 
  * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
  
 /* O ARQUIVO DE DEFINIÇÕES DO PIC UTILIZADO DEVE SER REFERENCIADO PARA QUE 
    OS NOMES DEFINIDOS PELA MICROCHIP POSSAM SER UTILIZADOS, SEM A NECESSIDADE 
    DE REDIGITAÇÃO. */ 
  
#include <p30F3014.h> 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                         Configurações para gravação                   * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
_FGS( CODE_PROT_OFF & GWRP_OFF ) 
_FOSC( CSW_FSCM_OFF & XT ) 
_FWDT( WDT_OFF ) 
_FBORPOR( MCLR_EN & PBOR_ON & BORV_45 & PWRT_4) 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                           Constantes internas                         * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *              Definição e inicialização das variáveis globais          * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
unsigned char TESTE; 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                       PROTOTIPAGEM DE FUNÇÕES                         * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                                ENTRADAS                               * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
// AS ENTRADAS DEVEM SER ASSOCIADAS A NOMES PARA FACILITAR A PROGRAMAÇÃO E 
//FUTURAS ALTERAÇÕES DO HARDWARE. 
 
#define BOTAO PORTBbits.RB0 //BOTÃO 
    //1 -> PRESSIONADO 
    //0 -> LIBERADO 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                                 SAÍDAS                              * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
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// AS SAÍDAS DEVEM SER ASSOCIADAS A NOMES PARA FACILITAR A PROGRAMAÇÃO E 
//FUTURAS ALTERAÇÕES DO HARDWARE. 
 
#define LED PORTBbits.RB1 //LED 
    //1 -> LIGADO 
    //0 -> DESLIGADO 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                         BLOCO DE FUNÇÕES                            * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                      BLOCO DE FUNÇÕES - ISR                         * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
/* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * 
 *                         FUNÇÃO PRINCIPAL                            * 
 * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * */ 
 
int main(void) 
{ 
 PORTA=0x0000;  // limpa PORTA 
 PORTB=0x0000;  // limpa PORTB 
 PORTC=0x0000;  // limpa PORTC 
 PORTD=0x0000;  // limpa PORTD 
 PORTF=0x0000;  // limpa PORTE 
  
 TRISA = 0b1111111111111111; //CONFIGURA DIREÇÃO DOS I/O´s 
 TRISB = 0b1111111111111101; 
 TRISC = 0b1111111111111111; 
 TRISD = 0b1111111111111111; 
 TRISF = 0b1111111111111111; 
 
 while(1) 
 { 
     TESTE = TESTE + 1; //INCREMANTA VARIÁVEL TESTE 
     if(!BOTAO) LED = 1; //TESTA BOTÃO. SE PRESSIONADO LED = 1; 
     else LED = 0;  //CASO CONTRÁRIO, LED = 0; 
 } 
} 
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13. Certicado de Garantia 
 

1. Tempo de Garantia 
 
A LabTools garante contra defeitos de fabricação durante 4 meses 
para mão de obra de conserto. 
O prazo de garantia começa a ser contado a partir da emissão do 
pedido de venda. 
 
2. Condições de Garantia 
 
Durante o prazo coberto pela garantia, à LabTools fará o reparo do 
defeito apresentado, ou substituirá o produto, se isso for necessário. 
Os produtos deverão ser encaminhados à LabTools, devidamente 
embalados por conta e risco do comprador, e acompanhados deste 
Certificado de Garantia “sem emendas ou rasuras” e da respectiva 
Nota Fiscal de aquisição. 
O atendimento para reparos dos defeitos nos produtos cobertos por 
este Certificado de Garantia será feito somente na LabTools, ficando, 
portanto, excluído o atendimento domiciliar. 
 
3. Exclusões de Garantia 
 
Estão excluídos da garantia os defeitos provenientes de: 
Alterações do produto ou dos equipamentos. 
Utilização incorreta do produto ou dos equipamentos. 
Queda, raio, incêndio ou descarga elétrica. 
Manutenção efetuada por pessoal não credenciado pela LabTools. 
Obs.:  Todas as características de funcionamento dos produtos 
LabTools estão em seus  respectivos manuais. 
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4. Limitação de Responsabilidade 
 
A presente garantia limita-se apenas ao reparo do defeito 
apresentado, a substituição do produto ou equipamento defeituoso. 
Nenhuma outra garantia, implícita ou explícita, é dada ao comprador.    
A LabTools não se responsabiliza por qualquer dano, perda, 
inconveniência ou prejuízo direto ou indireto que possa advir de uso 
ou inabilidade de se usarem os produtos cobertos por esta garantia. 
     
 
A LabTools estabelece o prazo de 30 dias (a ser contado a partir da 
data da nota Fiscal de Venda) para que seja reclamado qualquer 
eventual falta de componentes. 
 
 
Importante: Todas as despesas de frete e seguro são de 
responsabilidade do usuário, ou seja, em caso de necessidade o 
Cliente é responsável pelo encaminhamento do equipamento até a 
LabTools. 
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